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Attendance at the
February general meeting:
56 members and guests.

To Contact CIPCUG
The Outer Edge......................805-485-7121
General Information………...805-289-3960
Mailing Address...P.O. Box 51354, Oxnard, CA
93031-1354
On the Web: cipcug.org
On Facebook: Facebook.com/groups/cipcug

Coming computer tuneups
are free for new members
The computer tuneups at April’s meeting
are $15 for members but free for anyone who
joins from January to the March meeting date.
All the details are in a story on page 10. If you
didn’t take any CIPCUG business cards at the
last meeting (see Command.com on this page),
take a few this month and give them to a computer-owning friend along with the information on the tuneups. Note, however, that
reservations for a tuneup must be made on
cipcug.org.

Please complete the survey
The CIPCUG survey is available on cipcug.org. The board needs to know your wants
and interests to improve the group. We hope
to start tabulating late this month, so please
complete the survey as soon as possible.

By Jim Brown, President
“Promoting the Harmony of Computer Education, and Camaraderie”

M

arch is the month supposedly of winds — “in like a lion and
out as a lamb.” Winds may also signify change and unsettledness. I mention this because your board is having conversations with the Boys & Girls Club concerning the renewal of
our rental contract. So far, things are going as well as expected although we
have concerns on some items listed in the proposed contract. I ask all of you
to take a bit of time and look around for alternative sites where we can hold
our monthly meetings. We may need a back-up position if we cannot reach
an amicable agreement with the current B&GC administration. Certainly
there will be more information given at our March meeting. Our March meeting is Saturday, March 23, 2013.
As a reminder of coming events-especially — at our April
meeting:
We are scheduling a computer tuneup for your PCs for the
April meeting. The usual fee is $15.
If a new member joins our computer group from January to
April, we will offer the tuneup free of charge
We will update the new flash drives for $2. If you wish to
Brown
load your old CIPCUG flash drive with the new software, we
will do it for $5.
Our April raffle will feature a Nexus7 16-bit tablet. This is a beautiful bit
of hardware and very useful. There will be other great items for this raffle.
This should be fun and an opportunity to win nice items for just a few dollars.
The raffle ticket prices will be $5 each or five tickets for $20. This will be
similar to the raffle at our 25th anniversary celebration last September.
We printed business cards for our computer group. The purpose is to give
you something to give out to prospective future members. The card has all
the information needed to inform and connect to our group. We anticipate
that this will make it easier for all of us to give complete information to others. These business cards will be distributed at our March meeting and will
be available at future meetings.
Have you participated in our club survey yet? Your board wants to hear
(Continued on page 3)
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Have you used the F1 — Coming events
Gene Barlow to present
Your Help Key feature?

A

t the last meeting, Robert Provart asked me to
remove his name from the F1 — Your Help Key
feature that appears in most issues of TOE because he hasn’t had any calls in some time. His
comments make me wonder if the feature has outlived its
usefulness. Michael Shalkey told me he gets calls for help
but doesn’t know if they’re a result of the F1
listing or his regular appearances at every
Editor’s
meeting. David Minkin said he has had some
corner
calls.
When we had regular computer shows in
the county, people who looked through sample copies of TOE were surprised that there
were people who’d offer help for free. The
feature was a good selling point.
I’m interested in your use of the feature.
Weigle
Have you ever used it to get questions answered? If so, approximately how long ago did you use it
(days, weeks, months, years)? If no one is using it, I’m sure
I can find something to replace it, such as articles from other
newsletters that are shared regularly through the Association
of PC Users Groups (APCUG).
Please let me know what you think.
We lose a member
Art Lewis reported a death notice (no obituary) in The
Star for one of our members: “The Tuesday (Feb. 26) edition of the Ventura County Star reported the death February
22 of Barton Cook Wood, 90, Camarillo, electrical engineer.
I suspect that this is Bart Wood, a long time member No.
46. If anyone knows his family, a card would be appropriate, and perhaps a mention in TOE.”
Thanks, Art. We extend our sympathies to the Wood
family.

More on Command.com ...
(Continued from page 1)

your views and opinions. John Weigle and Toby Scott have
devoted many hours to this project. You can find the survey
on our Web site — www.cipcug.org. Please participate.
While you are there, take a look at our club bylaws. We will
have an election of officers — especially the office of president — in the spring.
Our April meeting should be fun-filled and informative.
Please send any suggestions to any board member. You
can send to board@cipcug.org, president@cipcug.org and
so on for all board members.
Hope to see all of you at our April meeting.
PS. I have been asked to be the marshal of the April
Fools Parade. I am not sure if this is an honor or what?

webinar in March proPrograms
Gene Barlow will present a webinar on “Organize and Protect
Your Hard Drive” at the March 23 meeting at the Camarillo Boys
& Girls Club, 1500 Temple Ave. (Ponderosa Drive and Temple
Avenue), Camarillo (see the map on the last page).
The doors will open at 8 a.m. and the program will start at
8:45 a.m. We expect to have the Internet and Connectivity SIG led
by Toby Scott.
Barlow will start by describing the various options you have to
better organize your hard drive to serve your needs. How you organize your hard drive can affect how protected your files are and
how easy it is to use them. He will show how he organizes his
hard drive and why he chose to do it that way. Then he will
demonstrate Acronis Disk Director 11, which makes organizing a
hard drive quick and easy.
Doing regular backups of a computer’s hard drive is the most
important thing a user can do to protect the content of a computer,
Barlow said. He will describe a backup approach that will give
users the best protection for their computers, he said. This will be
(Continued on page 4)

Door prizes
We have two types of raffle tickets: one for prizes offered by
the presenter and one for club-provided prizes. The tickets for the
presenter’s prizes are free and limited to one per member.
The tickets for the club-provided prizes are $1 each, $5 for six
tickets, $10 for 13 tickets, $15 for 20 tickets and $20 for 27 tickets
and are available to anyone. Those who can’t stay until the
drawing may sign their tickets and give the person selling the
tickets a list of the prizes they would like in the order they’d pick
them. Winners’ prizes will be held until the next meeting.

Consignment table
A consignment table is set up at every meeting. Anyone can
buy, but only members can sell.
The club gets 10 percent of the sales price. Sold items must
be picked up at the end of the day’s meeting.
Any items not picked up will become the property of CIPCUG
and will be subject to disposal at the club’s discretion.
CIPCUG is not responsible in any way for items bought or
sold at the table. Each item is sold as-is unless otherwise stated.

Meeting, SIG notices
If you would like e-mail notices of regular meetings and SIGs,
go to www.cipcug.org, where you’ll find a link on the home page
to sign up. The URL is cipcug.org/listserv.cfm.
You will need your membership number, which is on the
back cover of TOE, to complete the sign-up.
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Internet SIG, Q&A

Downloading YouTube videos, new Java issues
Unless otherwise noted, Toby Scott
answered the questions in the SIG and
the regular Q&A, assisted by Michael
Shalkey, who also handled the computer
duties for the SIG but had to leave before
the Q&A because of a prior commitment.
Internet and networking SIG
No social media SIG
Toby Scott: We’re having only one
SIG today because the last one on social
media and alternate devices had only a
few people and no questions when Jessica
tried to do a Q&A. We’re interested in
what you would like to have in the way of
SIGs.
Downloading YouTube videos
Q: How can I download audio and
video from YouTube? I used to have a

downloader, but it disappeared from my
computer. I think I have a Firefox add-on
for it.
A: Jessica: Look for a YouTube
download add-on for the browser you
use.
Toby: Use a Google search to find the
Firefox add-ons. The search engine on the
Firefox add-ons page is not very good.
Audience: There are several video
download helpers for Firefox. One of
them has an icon that looks like the icon
for Chrome, and that’s the one I use.
Jessica: I have a downloader on
Chrome.
Toby: If you’re geeky like I am, you
can play the file in your browser and then
go to your temporary Internet files, search
for *.swf, sort by date and check for the

latest download there and save it to a different folder. The file type depends on
what program the person posting it used,
but YouTube lists these formats as the
ones it supports: .MOV, .MPEG4, .AVI,
.WMV, .MPEGPS, .FLV and 3GPP.
They’d like to go to HTML5, but that’s a
ways off.
Michael: A good downloader for
Chrome is Chrome YouTube Downloader
2.6.5.
Jessica: I have FVD Downloader. (Its
description on the Web says it does not
support YouTube downloads. — Editor)
Java issues
Q: I can’t do the Sunday New York
Times crossword puzzle without Java
(Continued on page 5)

More on coming events ...
(Continued from page 3)

followed by a demonstration of Acronis
True Image 2013.
At the end of the meeting, Barlow
will offer a free software product to all
attendees to monitor the well-being of
their hard drives. He backs up his customers with a special Starter Guide and
extended technical support.
Barlow has worked with computers
for 50 years in various technical, marketing, and management positions. He had a
34-year career with IBM and managed its
User Group Support organization when
the IBM PC was introduced in 1981.
When he retired from IBM, he set up his
own consulting firm, User Group Relations, to continue to represent various
software companies to user groups.
Dates of coming meetings follow:
April 27
May 25
June 22
July 27
Aug. 24
Sept. 28

Oct. 26
Nov. 16 (third Saturday)
Dec. 21 (third Saturday)
SIGs
The Special Interest Groups (SIGs)
are sponsored by CIPCUG and led by
volunteer club members. They are free to
CIPCUG members.
Other than those presented during or
just after the regular meeting, the SIGs
run from 6:30 to 8:30 p.m. at Ventura
County Computers, 2175 Goodyear Ave.,
Unit 117, Ventura; phone 289-3960.
From the 101 Freeway, exit at Telephone,
take Telephone south to McGrath, turn
left and go one block. Turn right on
Goodyear and right again into the second
driveway. Unit 117 is the back, right
corner of the building.
The pre-meeting SIGs are at 8:45 a.m.
at the Boys & Girls Club. The aftermeeting SIG when one occurs is at a location to be announced on the meeting
day.
The general schedule:
Fourth Tuesday: Linux.

Fourth Saturday (or the regular
meeting day):Internet and connectivity
SIG (Toby Scott), 8:45 a.m. The location
of Michael Shalkey’s after-meeting SIG,
on days there is one is announced at the
meeting.
The March and April schedules:
March
Saturday, March 23: Pre-meeting
SIGs on the Internet and connectivity at
8:45 a.m.
Tuesday, March 26: Linux SIG.
Moderator: Bill Wayson. With luck, we
will finally get Ubuntu installed on our
refreshed CIPCUG PC. Of course, we
will entertain any questions, comments,
or anything else that interests you.
April
Tuesday, April 23: Linux SIG. Moderator: Bill Wayson. Topic TBA.
Saturday, April 27: Pre-meeting SIG
on Internet and email at 8:45 a.m.
Be sure to check the calendar on
cipcug.org for updates on event programs, dates and times.
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being enabled. Is it safe yet?
A: No, and many in the tech community don’t expect it to be for at least two
years. But, as we’ve said before, if you
have trusted sites that you must visit
(such as some financial sites and others),
disable Java in all your browsers except
one, and then use that browser to visit
only the trusted Java sites. Opera is a
good choice for this unless you’re already
using it as your primary browser. Internet
Explorer is not a good choice for the Java
-enabled browser. Do not perform Google
searches on the Java-enabled browser
because you might be directed to some
sites that have infected Java code.
Instructions to disable Java in popular
browsers were printed in the February
issue, which can be found at cipcug.org in
PDF format. The instructions are also
available at a number of Web sites because of the severity of the issues caused
by the Java problems. To disable Java in
all browsers, you can go to Start > Control Panel > Java and uncheck the box
“Enable Java in the browser.” This method will not work if you want to enable
Java in a single browser because it disables Java in all browsers.
Don’t willy nilly go around the Internet with Java enabled. New dangers come
up every day.
Q: Do sites tell you if they need Java?
A: Yes.
Using groups in Live Mail
Q: I’m using Live Mail in Windows 7
and developed a group of 10 people. It
shows in the TO: line, but only three people get the message.
A: I’d delete the group and start over.
I suspect that there’s a strange character
that you might not be able to see somewhere in the list of addresses.
Comment: When I hit the plus sign,
only three addresses show up.
Audience comment (This comment is
out of order but applies to this question):
Put the group name in the BCC: rather
than the TO: or CC: line. Then recipients
see only their own address, not the addresses of everyone the message was sent
to. Windows Live Mail shows all the addresses if you put them in TO: but does
not if you put them in BCC: (this is true

This month’s topics
Internet SIG
No social media SIG
Downloading YouTube videos
Java issues
Using groups in Live Mail
Internet speed tests
Copying files to seldom-used PC
Java and Firefox
Tiny URL dangers
“Invalid data file”
Deleting add-ons
Monitor goes black

of most email programs — Editor). If
your email provider insists on having an
address in the TO: line, use your own.
The “Reply all” function sends the reply
to the names in the TO: and CC: lines but
not those in the BCC: line.
Internet speed tests
Q: What’s the best tool to check my
Internet speed?
A: Speedtest.net, but it requires Java
to be enabled. I think that’s probably true
of all the sites that perform speed tests.
Speedtest.net gives you the most optimistic numbers, which is probably the reason
it’s the industry standard.
Copying files to seldom-used PC
Q: I have a Windows XP PC that I use
infrequently, but sometimes I want to
send a site link or other document to it. I
have no security programs on it. Am I
vulnerable if I sign it on to the Internet
just to send something to it?
A: I’d use sharing and let the folder be
shared with everyone. That will make the
file available to every computer on your
home network. If you’re not going to the
Internet, there is not much of a problem
on the computer. Microsoft used to make
Windows Home Server, which was the
perfect tool for situations like this, but
they stopped selling it.
Michael: If it’s just one or two files,
I’d copy them to a flash drive and
“sneaker net” — walk over to the other
computer — them to the other computer.
This also gives you a backup of the files
on the flash drive. If you have lots of files
to copy to the other computer, you could

Q&A session
iPod nano wipes out music
Music in the car
Deleting Gmail contacts
Opera problem
Screen recorder
Flash drive programs
Finding duplicate files
Speaker hum
Java
Skype
Secunia PSI
Windows 8 and Office
Compressed air

use Dropbox, Google Drive or a similar
site.
I’d put some security program on the
XP machine because it sounds like you
do go on the Internet with it sometimes.
Microsoft Security Essentials is free, gets
good reviews and works on XP. I wouldn’t use AVG.
The main thing is don’t blindly click
on links in emails or on Facebook. That’s
dangerous.
Q: I have some people who are computer wise and who I trust who send me
links I want to open.
Michael: That’s fine, but ask them to
send more than just a link with no message or a very generic message. You want
something personal enough to be sure it’s
really from the person you think it is and
not from a hacked email account.
Toby: A little bit of intelligence goes
a long way.
The key is not to blindly click on
links. If the message is so generic it could
have been sent to anyone (“check this
out,” “this is funny”), don’t click on the
link. Send an email to the person it’s supposed to be from asking if that person
really sent it. And when you do that, look
at the address it’s going to be sent to because if it’s a spoofed message, the email
address will be wrong.
You have to think before you click,
period. Before you install Microsoft Security Essentials, be sure to uninstall any
outdated security programs.
(Continued on page 6)
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Java and Firefox
Q: For about three days, I was having
Firefox crashes and got error messages
about Java heap dump. I have Norton
Anti-Virus. The problem stopped after a
Java update.
A: There could have been a problem
with the latest Java update. Oracle is doing updates almost weekly, and the problems aren’t being fixed because they’re in
the core of the code. They can’t fix the
way the hackers get in to the program
without rewriting the program, so they’re
blocking the ways people send code out
as they’re discovered.
Michael: It’s like putting a screen
door on a submarine and stacking more
and more screen doors on the first one to
keep the water out.
Tiny URL dangers
Q: Can’t Tiny URL links and similar
shortened URLs be dangerous?
A: Michael: They’re OK if you’re
sure who they’re from.
Toby: I’d treat a Tiny URL link like
any other link, but I’d trust it more than
some really long one that I can’t interpret.
Bit.ly is a similar Web site that shortens
URLs, and Google also has a URL shortener. All links are risky and you have to
decide if they meet the smell test: Is the
message from someone you know? Is it
so generic that it could have been sent to
anyone? Is the message related to something you mutually know about and a
hacker probably would not? If it’s hugely
generic, don’t click on it. But hackers
don’t generally use URL shorteners, so I
would be slightly less suspicious of one.
“Invalid data file”
Q: I’m getting an “invalid data file”
message when I shut down.
A: Something in the background is
trying to open or save a file that it can’t
find, that is marked read only or that is
corrupted. Norton won’t detect this kind
of problem with a specific file. You need
to figure out what program is putting up
the message and work from there.
Q: WinZip keeps popping and starts
to scan the computer. I stop the scan, and
another message comes up and says I
have lots of errors.
A: Michael: WinZip shouldn’t need to

scan your computer. You’re infected with
something. It will probably give you a
message that if you send us money we’ll
fix
your
computer.
It’s
called
“ransomware.” It’s very hard to find because it’s purposely hidden.
Toby: Whatever it is, it’s going to be
difficult to get rid of. It’s probably best to
bring it into the shop.
Deleting add-ons
Q: If I use a browser add-on, where
does it go? Is it in the program files or the
browser files?
A: Add-ons are attached to the browser and will be in the browser set-up file.
The add-ons are generally in the Applications Data folder in Windows Vista and 7,
which is generally a hidden folder. The
add-ons are attached to the browser. If
you simply delete the files for them and
don’t do a proper removal, you can create
a continuing error in the browser. Go to
the add-on in the browser and click on
remove to properly delete it.
Monitor goes black
Q: On both my desktop and laptop, if
I stop working for a while, the screen
goes black.
A: Michael: Right mouse click on the
desktop, click on Personalize, go to
screen saver and change the power plan
to adjust the time that the computer must
be inactive to start the screen saver.
Q&A session
iPod nano wipes out music
Toby Scott: Before we start the Q&A,
I’m going to discuss a near disaster that
we had at home when Jessica plugged an
Apple iPod nano into her computer,
which is synchronized with mine. She
installed iTunes. With no warning, it
started to automatically synchronize her
iTunes, and the program eliminated 48
gigabytes of music from my computer.
This included a lot of music that we had
recorded at home, including hours of music recorded by Sofia Cosma, a prominent
concert pianist and the mother of Toby’s
wife, and other music the family had recorded. I have a backup, but it took seven
hours to restore the music, and I’m still
not happy about what happened. Apple
deleted things because they weren’t
bought at the iTunes store. Apple said

you didn’t buy these from iTunes so they
shouldn’t be there. It went across the network and eliminated them from my computer.
Jessica: In my defense, the synchronizing started automatically when I
plugged it in. I wasn’t asked, and no option was offered to not synchronize or
synchronize manually.
Toby: Apple wants to own everything
in the world, and they don’t want you to
have anything you didn’t buy from them.
Michael: I’ve had three friends who
had problems with iTunes. I went to the
Apple Store, and they said you’re running
Windows. Buy a Mac.
Andy Toth: Someone gave me an
iPod, which is a pain to connect to Windows 7. I’ve had good experience Media
Monkey, but it runs iTunes in the background. One of the other programs — at
Floola.com — lets you put a little firewall
up to protect your music.
(After the meeting, Andy sent the
following information:
(Here's a link. http://www.ehow.com/
how_2049669_add-music-ipoditunes.html
(I got my ipod connected via MediaMonkey. There is also a plug-in for sale
into Media Player; it is $20. It has a weird
spelling. Do a Google search for “ipod
without itunes.” — Editor)'
Toby: Apple goes out on your home
network and wipes out all the music. If I
had backed my computer up to my wife’s
computer, my backup would have been
eliminated. I don’t share my flash drive.
Apple doesn’t play nice with anybody.
Michael: You probably think that
when you buy music online, you’re buying the song like you used to buy a record, tape or CD, but you’re actually just
buying a license to listen to the music.
Toby: Poddox, which is on the flash
drive under audio tools, allows drag and
drop synchronization. It can replace Microsoft’s Media Player and iTunes. We’ll
add some players to the update of the
CIPCUG flash drive.
Andy Toth: It does require iTunes in
the background.
Michael: Poddox does not require
iTunes. MediaMonkey does.
(Continued on page 7)
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Toby: The well-designed VLC media
player, also on the flash drive, works
without iTunes and is, I believe, the most
downloaded media player.
Jessica: Another thing about Apple is
that it plays only its own file types. It
does play MP3s.
(A Web search after the meeting
turned up many complaints about iTunes
synchronization during the past several
years, although most of them concerned
music being wiped off the iPod rather
than the computers. Apparently, the activity has been known for several years, and
one of the responses on an Internet help
board said if the questioner had read the
manual he’d have known what was going
to happen. About.com contains these instructions to turn off automatic synchronization:
(“1. Before you plug the iPhone or
iPod into the computer, go to iTunes.
(“2. On a Mac, go to the iTunes menu
-> Preferences -> Devices.
(“On a PC, go to Edit -> Settings ->
Devices
(“3. In the pop up window, look for
the icon or tab that says Devices. Choose
it.
(“4. Just below the box, you’ll see a
checkbox reading ‘Prevent iPods,
iPhones, and iPads from syncing automatically.’
(“5. Check it and click OK at the bottom of the window.
(“Auto-sync is now turned off and
you’re safe to plug your iPod or iPhone
into the computer.”
(I do not have iTunes so have no way
to confirm that this works. It’s included
here for your information. — Editor)
Music in the car
Q: I bought a song and copied it to a
disc, but it won’t play in the car.
A: It’s probably a format issue. Most
car players don’t play MP3 files.
Jessica: A lot of the newer cars have
players that do play MP3 files.
Toby: They might play MP3 files off
an MP3 player but not off a CD.
Deleting Gmail contacts
Q: How do I eliminate an old address
from my Gmail account?
A: In Gmail, click on the Gmail logo

in the upper left of the home page, go to
Contacts > More and delete the address
you’ve highlighted. There’s also an option to delete all contacts, which you
probably won’t want to do.
Opera problem
Q: I updated Opera, and when I pull
up my AOL email account it displays for
a few seconds and then stacks up in the
left column and becomes unreadable.
A: I’m guessing on this, but try enabling Java on the browser and see if that
helps. It’s possible that AOL is using Java
in its email program. I don’t think Opera
would have changed any settings with an
update that would cause that problem.
Screen recorder
Q: Is there a free screen recorder to
capture both audio and video for Windows 7?
A: VirtualDub on the flash drive is
highly recommended. I haven’t used it,
but it gets good reviews.
Michael: Cam Studio is also good. It’s
open source freeware and can be found at
http://camstudio.org.
Flash drive programs
Toby: If any of you have favorite freeware programs that you think should be
on the flash drive, please let me know.
We can add them; we already have several to add to the first update we do. If everything goes as planned, we’ll have updates available at the next meeting — and
I’ll remember to bring the remaining flash
drives that I had planned to bring today.
Finding duplicate files
Q: Is there a good duplicate files finder?
A: Duplicate File Finder (http://
www.auslogics.com/en/software/
duplicate-file-finder) and one other one I
don’t remember the name of.
Audience: You can do it in DOS.
Toby: The DOS search will find files
with identical names, but it doesn’t examine the checksums to be sure the files are
identical. The ones I’m thinking of do.
Speaker hum
Q: My computer speakers are emitting
a 60 gigahertz hum.
A: You might have to get new speakers, but before you do that, try a new connecting wire, which is often the problem.

If that doesn’t work, try jiggling the wire
and, if you can, turning the plug over in
case the ground is wrong.
Java
Q: You’ve been saying to disable Java, but earlier you told someone to turn it
on. I keep getting update notices. Should I
allow them?
A: Definitely allow the updates. They
are attempts to fix serious security problems.
Let’s review the issue: The general
recommendation is to turn Java off because it has security holes that can’t be
easily fixed, but some sites, including
some financial ones, still require it. If you
visit such sites, my advice is to enable
Java in a secondary browser. As noted in
the SIG, Opera is a good choice for this
unless you use it as your primary browser. Then use that Java-enabled browser to
visit the trusted sites that require Java. Do
not use it for general Web surfing or even
Web searches. If you go to a site that you
don’t know is safe that says you need
Java, leave it. Again, don’t make the Java
-enabled browser your primary browser.
Q: My latest Java update did not show
the usual information on the version.
A: I’d go to java.com and download
from there just in case the one you received is not valid. I don’t know of any
hacks of Java itself, but there’s no reason
to take any chances. As you install, watch
the screen carefully because one of them
will offer to install the Ask toolbar, and
the default is “agree.” Ask is questionable
at best; it installs the toolbar and changes
your home page. Then Ask lists only
sites that have paid them. If you accidentally install it, uninstall it from “Add
or remove programs.” Such actions are
making lots of people unhappy with Oracle, and some techies are calling it greedy
and sleazy, a term they seldom use for big
companies.
I’m wagering that two years from now
we won’t be using Java. There will be an
open source substitute for it.
Oracle has sold OpenOffice, which
came with its purchase of Sun, to the
Apache Foundation for $1 because so
many people who were unhappy about
(Continued on page 8)
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Program: CIPCUG flash drive

Opera, SyncBack, VLC are demonstrated
By John Weigle
jweigle@vcnet.com
oby Scott continued his presentation on software on the CIPCUG flash drive at February’s
meeting, covering Opera, a
Web browser; SyncBack, a backup program; and, in less detail, VLC, a media
player.
Opera
Scott uses Firefox as his main browser because he likes the way it can be personalized with add-ons and because it can
keep multiple pages open with no problems. But if he just wants to take a quick
look at a site, he uses Opera as a second
browser because it opens faster than Firefox.
Opera creates a Speed Dial page that
opens when a user opens a new tab.
Opera offers its own suggestions, but
users can add their own favorites and

T

delete other pages at any time. Users can
make the Speed Dial page or any other
page their home page.
The default Speed Dial set-up is nine
sites, but the Opera Help file says users
can add as many sites as they want, although the page thumbnails get smaller
with each addition. Users can also have
up to nine pages open automatically
when the browser is opened.
“For your occasional browser, it
works really, really well,” Scott said.
A member of the audience suggested
that Opera could be the Java-enabled
browser, and the pages needing Java
could be the ones on the Speed Dial page.
Another person asked how to delete a site
from the Speed Dial page, and Scott said
to right click on the thumbnail and chose
the Delete option from the dropdown
menu. Other options are to edit the entry,
reload the page, and reload the page after
specific time passes.

Similar features are available in
Chrome and Firefox with add-ons, he
said.
Another person asked if bookmarks
can be imported, and the answer is that
they can by going to File > Import and
Export and picking the browser you want
to import from (the choices are Opera,
Internet Explorer, Firefox and Konqueror. Scott suggested that those who are
going to use Opera as the Java-enabled
browser might not want to import all their
bookmarks, however.
Opera also has add-ons available, and
they can be obtained from the Tools >
Extensions menu.
Scott said he wouldn’t use Opera to
visit hundreds of sites in a day, but it’s
perfect for visiting just a few sites in a
day.
Asked if it’s possible to direct email
links to specific browsers, Scott said no.

outdated because of security issues.
Hackers used to be teenagers who just
wanted bragging rights or the ability to
post a “gotcha” message, but now most
of them are part of organized crime in the
Eastern block and the hackers have far
more nefarious goals.
Secunia PSI
Q: How good is Secunia PSI to alert
you to needed updates?
A: It’s OK, but it will nag you on
programs that don’t go online.
Q: So are you saying to stay away
from Skype?
A: No, it’s one of the best programs
developed in the past several years, but it
does a lot and is highly vulnerable to attacks, so you have to keep it updated.
Comment: I use Skype all the time for
my grandchildren on the East Coast.
A friend in Arizona told me that when
she gets email in Outlook if the people
are on Skype she gets an information box
with the sender’s Skype information.

A: Michael: I don’t think it’s related
to the version of Windows but to the version of Outlook being used.
Toby: If you use Windows RT,
there’s a single contact list for Skype,
Windows Live Mail and chat and other
programs that need contacts.
Windows 8 and Office
Q: I downloaded Windows 8 but have
not installed it. If I install it, will the Office I’m using on Windows 7 work in it?
A: Yes.
Compressed air
When Craig announced that one of
the raffle prizes was compressed air, Toby asked if it was specifically for electronics, and Craig said yes.
Toby said there are two types of compressed air, with one having an oil propellant. Oil will conduct electricity, and if
you spray it on your mother board you
can short the board out. Be sure that any
compressed air you buy is labeled as being for electronics.

(Continued on page 9)

More on Q&A ...
(Continued from page 7)

working with Oracle abandoned OpenOffice for LibreOffice. I think Java might
go the same route.
Skype
Q: Skype has been asking me to let it
run a system check and update. I denied
the access. I don’t know what to do with
it.
A: There are several things about
Skype. You might have noticed that Microsoft Messenger has disappeared. Microsoft replaced it with Skype Chat because it wants you to use Skype as both
the phone and IM software. Skype is positioned to become the chat engine of
choice. By default, it starts when Windows opens and runs in the background
all the time. You can change that and can
also open only the messenger function on
startup. If you run it in the background all
the time, be sure to keep it updated. You
don’t want any programs that run all the
time and connect to the Internet to be
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Some email programs offer users a Send
to option that might work for that. The
only other option is to copy the link and
paste it into the browser.
To disable Java in Opera go to Tools
> Advanced > Plug-ins.
SyncBack
Before showing SyncBack, Scott reviewed the two types of backups.
One is the so-called “bare metal” or
full system backup, which copies everything on the drive, including the operating
system, programs and documents. This
kind of backup can be performed easily
with a backup tool built into Windows 7
and 8 (Control Panel > Backup and Restore). This is the kind of backup you
want to have available if your hard drive
fails because once the full backup is
placed on the new drive, everything is in
the same condition it was when the backup was made. To restore the drive from
such a backup, start to install Windows
from the original CD or DVD and wait
for the “restore from backup” option. It’s
better if you burn a restore disc on a CD.
People using XP or Vista probably
won’t need this kind of backup because
they’ll want to upgrade to a later version
of Windows, Scott said, noting that Microsoft will end all support for XP next
year, which means that if hackers find
new security weaknesses, no patches will
be issued. Those who think that’s a ridiculous policy need to remember that Microsoft is supporting XP, Vista and Windows 7 and 8. XP is 13 years old, which
is a long time for computer operating
systems. Apple, on the other hand, is supporting just one version of its OS.
The other type of backup copies only
files that the user selects — usually data
files. SyncBack, which comes in both
free and paid versions, is an excellent tool
for this kind of backup, Scott said.
“You can back up any data that you
want to,” he said.
Users create a profile in which they
select what folders and subfolders to back
up. For demonstration purposes, Scott
picked My Documents and all its subfolders, but users can back up just music and
pictures files if they want to. After choosing what to back up, users select the des-

tination to store the backed up files.
Users can schedule backups with the
Windows scheduler, but to do that, they
must have a login password because the
scheduler requires it. Users can also
choose to overwrite files, skip files or
save several versions of files if they want
to.
They also choose what to do if a file
is no longer present on the source drive:
delete the file from the backup or keep it.
Keeping the file in the backup allows for
restoration of files that were accidentally
deleted, Scott said.
Users can back up to any device that
has the capacity to hold the material being backed up. This can be determined by
running a simulated backup after setting
up the profile to be sure the settings are
correct and the size of the backup, he
said. If users move a file on the source
drive, the default is to copy the file to its
new location in the backup and also leave
it in the original location so users will
have two copies.
Windows Backup can do a file backup, but it puts all the files in a giant ziplike file, so they can be restored only with
the restore function. SyncBack stores
files just as they are on the original computer and allows users to restore single
files easily.
SyncBack “does a really good job” of
making backups and not duplicating files,
he said
Asked how backups can be verified,
Scott said to move a file on the source
computer to a different location and ask
the backup program to restore that file. If
a file can be restored from deep in the
backup, the backup, is OK, he said.
Installing a new version of SyncBack
does not erase settings from the previous
installation, he said. The new version
pulls the settings from the old version.
To change various options, go to Decisions > Files. In Expert > When > Periodically, users can tell the program how
often to do backups in the background.
Asked if the Windows backup program backs up all partitions on the source
drive, Scott said the default is supposed
to be for all partitions but added that it’s
best to check what it says it will do after
setting up the profile.

VLC
The presentation on VLC was less
detailed than the other two because the
latest version had a revamped interface
that Scott had not expected. To set up a
playlist, click Media > Open File and
navigate to your media. Select what you
want to play/have on your playlist. The
selection(s) start playing immediately.
Once you have all the media you want on
the playlist, click on the Playlist icon at
the bottom and then click on Media, Save
Playlist to File. Navigate to where you
want to save your playlists, give it a name
and save.
If you have only one playlist, it will
play automatically when you start VLC.
If you have more than one playlist, you
select the one you want to play from the
Media > Open Recent Media dialog. In
the old version, you could select playlists
from the playlist menu, but it either was
removed or isn’t working correctly.
VLC plays all types of media files —
music, audio, and even ISOs (image files
of a CD, DVD or BD) — and lets users
create and name playlists.
“Once you get it set up, it has every
option known to man,” Scott said, including the ability to convert files to new formats. Music in playlists can be played in
random order with the hot key R, or from
the Playlist interface, select the Random
icon at the bottom.
“It has a tremendous amount of
tools,” Scott said, but users have to get in
and play with it to learn all the features.
Simply playing media is easy, he added.
An
online
Wiki
(http://
wiki.videolan.org) offers many pages of
help files and other information that tells
how to do anything you’ve ever thought
of and some you haven’t, Scott said.
Scott said he uses the paid version of
Winamp — the free version has lots of
nag screens — but if he was starting over
he’d use VLC.
A member of the audience said he
keeps his music files in My Music but
also sees references to them in libraries
and asked how the two fit together. The
items in libraries are simply shortcuts to
the original music file, Scott said, and if
you move the files, they won’t play if you
click on a library shortcut.
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Treasurer’s report
New members eligible
for free computer tuneup for January 2013

T

he next computer tuneup will be offered at the April
meeting with a special twist to attract new members.
Any nonmembers who register for the event on
cipcug.org and join CIPCUG from January to the
April meeting will get the tuneup for free. The price for members is $15.
Staff members from Ventura County Computers will check
computers for obvious problems, fix the simple ones and make
recommendations to solve more serious problems, such as the
need for new hardware, reinstallation of Windows and major
malware infections.
There will be a limited number of spots available because
the tuneups must be completed during the meeting.
Those who sign up for a tuneup will need to take the computer and the power assembly for laptops. Also, if you have a

Minutes of the February
board of directors meeting
By Diane Mortensen-Henderson
CIPCUG Board of Directors held its monthly meeting on
Feb. 16, 2013. Members in attendance were John Weigle, Andy
Toth, Craig Ladd, Art Lewis, Helen Long, and Toby Scott.
Absent were Diane Mortensen-Henderson and Jim Brown
In Jim’s absence, the meeting was called to order by Craig
Ladd.
Treasurer’s report: Art passed out copies of
the January 2013 treasurer’s report, which is
published elsewhere in TOE.
Future Programs: craig announced that he is
setting up a Webinar for the March 23 meeting.
Using Skype, it will be a presentation by Gene
Barlow. Craig once again thanked Toby and
Mortensen- Michael for their second presentation on addiHenderson
tional freeware programs. Board members
agreed that at April’s meeting we’ll have a large
purchase item, such as a Nexus, as a door prize. Tickets will be
set at $5 each or five tickets for $20.
Computer tuneup: CIPCUG’s famous tuneup session is
now set for April 27, 2013. This will be a fundraising event for
the club. Members will be charged $15. A proposed incentive
for anyone who buys a CIPCUG membership on or before the
day of the tuneup will receive a free computer tuneup. A flier
could be made up publicizing the membership/tuneup special
and distributed locally.
CIPCUG survey: Toby announced that he had received
approximately 20 responses from CIPCUG’s website. He will
(Continued on page 12)

By Art Lewis
treasurer@cipcug.org
1-1-13 through
1-31-13

Lewis

Category Description
INFLOWS
Coffee Income
Donation
Membership Income
Renewals
540.00
TOTAL Membership Income
Publication sales
Raffle

540.00
39.99
156.00

TOTAL INFLOWS

756.99

14.00
7.00

OUTFLOWS
Corporate Expenses
Raffle Prizes
Rent Paid
TOE

38.87
103.77
240.00
505.43

TOTAL OUTFLOWS

1,048.07

OVERALL TOTAL

-281.08

Unrestricted Funds
Restricted Funds
Bank Balance 1-31-13
Year to Date Income
Year to Date Expense
Net Year to Date

4,570.69
0.00
4,570.69
5,522.09
5,755.36
-233.27

Corrected summary for December
2012 treasurer’s report
Unrestricted Funds
Restricted Funds
Bank Balance 12-31-12
Year to Date Income
Year to Date Expense
Net Year to Date

4,851.77
0.00
4,851.77
4,765.10
4,717.29
47.81
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January 2013 renewals payment due:

Membership report:

Is it time to renew?

Mbr# Last Name

First Name Pd to Dt

By Ken Church

0926

Curry

Rick

201301

email address: membership@cipcug.org

1217

Donohue

Joseph

201301

Welcome –
New members: Much appreciated

CHURCH

February 2013 renewals payment due:
Attendance at the February 2013 general meeting:
56 members and guests (who signed in)

Mbr# Last Name

First Name Pd to Dt

1168

Brown

James

201302

1129

Escobedo

Ray

201302

MEMBER RENEWAL INFORMATION
$30 for single membership,
$35 for two or more family membership.

1063

Field

Dwayne

201302

1063
A

Field

Sharon

201302

NEW MEMBER INFORMATION
$40 first year for single membership,
$55 first year for two or more family membership in same household.

1219

Hernandez

Rafael

201302

0843

Isaman

Harry

201302

0566

Meeker

Kirsten

201302

0565

Meeker

Mary

201302

0656
T

Mori

Ken

201302

1083

Stoutz

Hank

201302

1140

Wayson

Bill

201302

Total membership: 175

Please send your payment to:
CIPCUG MEMBERSHIP
P.O. BOX 51354
OXNARD, CA 93031-1354
Or bring your payment to the sign-in table for
the March 23, 2013, meeting.

2013 contributors to The Outer Edge
Your name can appear here, too.
Share your knowledge with other
members by sending an article,
letters or computer tips to
editor@cipcug.org.
CIPCUG MEMBERS
Ken Church
Art Lewis
Helen Long
Diane Mortensen-Henderson
Dick Maybach

Tony Pizza
Toby Scott
Michael Shalkey
Rick Smith
Jim Thornton
Bill Wayson
John Weigle
APCUG
Jim Ceray
Nancy DeMarte
Nancy Preffitt

March 2013 renewals payment due:
Mbr# Last Name

First Name Pd to Dt

0544

Beardshear

Paul

201303

0054
T

Erickson

Elden

201303

0917

Johnson

Barbara

201303

1220

Johnson

Vic

201303

0138

Lakes

Arline

201303

0137

Lakes

George

201303

0425

Ledner, MD

Bob

201303

1050

Wennerholm Ernest

201303

1051

Wennerholm Naomi

201303

0771

Zuromski

201303

Alexandra

Page 12

The Outer Edge

March 2013

General news and commentary

Transferring really large files
By Bill Wayson
bwayson@gmail.com
n the Pleistocene era of personal
computing, transferring files between computers was simple. Copy
them to a floppy disk, use sneakernet (aka walk) to transfer the disk to the
destination PC, and
Penguin’s
copy them from the
Lair
disk. Much the same
technique is used today
— only the transfer medium has changed, becoming USB thumb
drives or optical discs.
Still, transferring files
may be challenging:
they may be too big for
the media. DVDs can
Wayson
hold anywhere from 4.7
to 9.4 GB, and many USB thumb drives
have a file size limit of about 4 GB imposed by the file system. If you must
transfer a really huge file, a different solution is required. This month we will
look at alternatives for transferring large
(and small) files.
The easiest way to transfer files is
through a network. Files of any size can
be handled, and you may not even need to
go to the destination computer. If you are
able to create shares between the two
computers, this may be an option. Linux
shares can be created using applications

I

More on board minutes ...
(Continued from page 10)

send the responses to Craig for his review.
Attendance: It was noted that in spite
of the change in schedule, from meeting
on the third Saturday in February instead
of the regular fourth Saturday, 61 members attended today’s meeting. CIPCUG’s business cards were set out for
members to take and distribute to individuals who may be interested in attending club meetings.
There being no further business to
discuss, the meeting was adjourned.

like NFS (Network File System) and
Samba. Samba is preferred when the other computer is a Windows PC since it
creates Windows-compatible shares.
Windows-to-Windows transfers are easily
done using Windows shares. Depending
on the situation, either the location of the
source files or the destination needs to be
under the share. Once created, though, the
transfer is most easily accomplished using the PC’s file manager and its familiar
file manipulation capabilities such as
copy-and-paste and drag-and-drop.
If folder shares are not an option, the
next method to try is an established transfer protocol such as FTP, SFTP, or SCP.
The only requirements are that the remote
PC run an appropriate service, the local
PC has an appropriate client, and you
have access to the local PC with the proper rights to access the service on the remote.
FTP (File Transfer Protocol) works
but is insecure. Minimal effort and
knowledge is required to learn the password, so few, if any, Linux distributions
install an FTP server by default. Most of
them do install an SFTP (Secure FTP)
service and clients. SFTP is secure because the entire transfer session, from
logon to logoff, is encrypted. Both SFTP
and SCP (Secure CoPy) clients connect
with SFTP services. They differ in that
SFTP works interactively until you close
the session, whereas SCP only copies
files listed in the command line. Using
SFTP is more convenient in many desktop environments which support it within
their file managers. Once connected, the
remote system looks like another folder,
and copying files is handled through familiar mouse operations. A Windows
package with client programs that I like
and
use
frequently
is
PuTTY
(www.chiark.greenend.org.uk/~sgtatham/
putty/). It will give you SFTP and SCP
clients, as well as others. Windows users
will need to search the Internet to find an
appropriate service. And don’t forget to
configure any firewalls to allow the protocol.
Another network option is to use one

of the cloud-based storage services. Copy
your files from the source PC up to the
cloud, then copy them back down to the
destination PC. This ought to be pretty
simple, and there is no requirement that
the two PCs be able to talk to each other.
This method does have its own issues to
consider. Cloud storage services usually
require some sort of registration. You
may also be uncomfortable having your
files sitting on someone else's computer.
Free cloud storage services exist, but they
often limit the total amount of storage
available, some of which may already be
used. Adding additional storage capacity
results in ongoing charges. The users of
both PCs must be able to access the same
cloud storage area, which may require
one user revealing their login ID and
password to the other (who may then
have access to other files). But, in the
right circumstances, such as a single user
with multiple PCs, this is a viable option.
If a network-based transfer solution
will not work for your circumstances,
then you must use an intermediary medium. You can try to compress the file
down to a workable size. File compression works well on many file types, such
as text documents and spreadsheets.
However, compression works less well
on file types that are already compressed
by the very nature of the file type. Multimedia files, in particular, such as MP3
audio files and jpeg pictures are already
stored in a compressed format, so compressing them again results in very little
size reduction. And your huge file is likely to be a multimedia file, such as a movie. But when file compression reduces the
file size significantly, it is a good option.
Another media-based solution is to
eliminate the file size issue completely by
reformatting the media to a file system
that supports huge file sizes. Windows
users can reformat their USB keys using
NTFS. If the source computer is a Windows PC, I see little downside to this.
However, some operating systems, notably the Apple Macintosh, cannot directly
write to an NTFS drive without additional
(Continued on page 13)
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Take control of your fonts
By Nancy DeMarte
Regular Columnist (Office Talk),
Sarasota PCUG, Florida
January 2013 issue, The Monitor
www.spcug.org
ndemarte (at) Verizon.net

Y

ou know you’re becoming a
real techie when you start to
question standard (default)
settings on your computer.
This fact is true when considering fonts,
which means text and other characters of
a certain style. Windows operating systems come with dozens of fonts; Microsoft Office adds even more with its
installation. For years the default font in
Office was Times New Roman in Word
and Arial in the other Office programs.
When the default fonts changed with Office 2007, many users didn’t care for the
new look but accepted it grudgingly. Perhaps they didn’t realize they could set
another font as their default. They may
not have known that they could also
download and install other fonts from the
Internet. This article explains how to take

control of your fonts and use them in creative ways.
The background
In the early days of computing, text
characters had unnatural, jagged edges.
Fortunately, the look and variety of fonts
have improved dramatically. TrueType
font format was designed by Apple in
1991, and Open Type, jointly developed
by Microsoft and Adobe, appeared in
1997. Clear Type greatly improved the
clarity of text on flat screens and laptops.
Today most text appears smooth and
clear, even at very small sizes and in
many alphabets, such as Latin, Greek,
and Japanese, and Arabic.
Finding your fonts
Fonts are stored in the Fonts control
panel of Windows. (Type “fonts” in the
Start menu search box or click the Start
button >
Control Panel > Fonts.)
Thumbnails of the fonts currently available on your computer are grouped alphabetically. The fonts that are installed depend on the languages which are enabled.
My font list, for example, shows only

English fonts. Double-clicking a font
thumbnail reveals the font in the sentence, “The quick brown fox jumps over
the lazy dog,” followed by the numbers
“1234567890” repeated in different sizes.
Fonts are organized by families, which
include various sizes and styles like regular, italic, condensed, and narrow.
Windows 7 added 48 new fonts to the
list, many in lesser known languages.
Office includes custom fonts with each
new release. If you purchased Office
2007 or 2010, you noticed right away the
new default fonts: Cambria for headings
and Calibri for the body of a document.
According to Microsoft, the most popular
five fonts in their products are Gill Sans,
Calibri, Arial, Curlz MT, and Times New
Roman.
Changing the default font
With little effort, you can change the
font that is standard in an Office program.
On the Home tab in Word 2007 or 2010,
click the small arrow in the bottom right
corner of the Font group to open the Font
(Continued on page 14)

More on Penguin’s lair ...
(Continued from page 12)

work. Users of Linux can easily reformat
their portable media to one of the ext file
systems, all of which support enormous
file sizes. Most recommend that USB
thumb drives use the ext2 file system
since it reduces the number of writes to
the media, prolonging its life. Linux-toLinux transfers can be completed easily
using this method. Work is required on
Macintosh and Windows computers,
however, to install third-party software
which will allow them to read from and
write to ext file systems.
If none of the solutions above meet
your needs, then one of your few remaining options is to split the file into manageable chunks. Linux and Macintosh
users can run the “split” utility to easily
split a file into the necessary number of
parts, each of which will be no larger than

a user-specified size. Each chunk can be
transferred using portable media to the
remote computer, and then easily reassembled back to the original file. Just
remember to reassemble the parts in the
proper order. Windows users will need to
do some searching on the Internet for filesplitting utilities.
Transferring files between computers
is usually a simple process. If the file is
too large, however, the process requires
some reflection on the particular situation, such as where the computers are,
who will use them, the file type, and
such. One or more solutions exist for almost all possible situations. Some require, at most, one-time setup work. It
may be worthwhile, though, to put work
into the setup if it results in a simple
transfer process.
If you find yourself needing to trans-

fer huge files, or if you just want to be
prepared to do so, spend some time considering your situation and don’t be afraid
of the setup work. You will probably end
up with a new tool on your PC that can
make your ongoing computing life simpler.
If you have questions or would like to
learn more about Linux and FOSS, come
to the March CIPCUG Linux SIG meeting at 6:30 p.m. Tuesday the 26th at Ventura County Computers in Ventura.
Again, with luck, we will finally get Ubuntu installed on our refreshed CIPCUG
PC. Of course, we will entertain any
questions, comments, or anything else
that interests you.
If there is something you would like
the Lair or Linux SIG to cover, drop me a
line at bwayson@gmail.com. Until next
month, happy computing.
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dialog box. Select a font name, style, and
size, and then click, “Set as Default” >
OK.
Getting a new font from the Internet
You can also search the Internet to
find new fonts, some offered for a price
and some free. These can be downloaded
and installed to the Fonts control panel,
where they will be available to any program on your computer which uses text.
My new fonts can be used not only in MS
Office programs, but also in Photoshop
Elements and PrintMaster, as well as
others where text is needed.
I wanted to send a homemade Valentine greeting card to my daughter using a
font that had that theme. Searching with
Google offered me many websites that
had free custom fonts for download. I
knew that any free download has the possibility of containing bugs or malware.
So I researched a bit more and decided to
focus on three of the many reputable free
font
sites:
1001freefonts.com,

dafont.com, and fontspace.com.
I
searched the Valentine category in
dafont.com, found a font I liked, clicked
the Download button and then the Save
button twice, which scanned the setup
file for viruses and saved it in my Downloads folder. Then I opened my Downloads folder (Start > Nancy > Downloads), opened the new font setup file,
and clicked Install. The process was automatic and quick. I closed all open windows, opened Word, and scrolled down
the font list to my new font, called MC
Sweetie Hearts. Using it, I designed a
simple greeting card, which I printed and
mailed.

if he doesn’t also have it installed. Instead, the text will revert back to the default font of the program that opens the
attachment. If you want to delete a font
from my computer, locate it in the Font
control panel, right click it, and click
Delete. A warning: deletions are permanent.
Using fonts creatively
Exploring the fonts on your computer
is fun and will probably make you want
to make better use of them. For instance,
open a word-processing program like
Word and scroll down the font name list
on the Home tab to the three fonts called
Wingdings. They are “Dingbats” — that
is, fonts where text characters have been
replaced by pictures and symbols. You
can’t use Wingdings to write a contract,
but you might find an occasion to include
a telephone, pair of scissors or arrow in
the body of a letter.
CAUTIONS: If you create a product
Even if you don’t download any new
with a downloaded custom font and send fonts or include Wingdings in your docuit digitally, such as an email attachment,
the person won’t be able to view the font
(Continued on page 15)

(805) 289-3960
2175 Goodyear Ave. #117 Ventura 93003

Would someone please explain
to me why anyone in their right
mind would choose Windows
windows 88
when you have Windows
windows 7.
7.It’s
It’s
like jumping out of a perfectly
good airplane.

Rick, I gave you Microsoft’s talking
. points.
All you have to do is
it tow
toe the
the
company line to start selling new PCs
PC’s
with the world’s most advanced OS.
Get with the program!

As everybody knows I’m always right about everything and
there’s nothing I’m not knowledgeable about. And I know
this,Rick,
Rickyou’re
your wrong
this,
wrongabout
about
windows 88 and
Windows
and if
if you
you have
have 22
hours I’ll tell you why.
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Connecting things
to your computer:
the USB port
By Jim Cerny
Director, Sarasota PCUG, Florida
December 2012 issue, Sarasota PC Monitor
www.spcug.org
jimcerny123 (at) gmail.com

P

rinters, cameras, flash drives — is there any limit to
what you can connect to your computer? Today we
want to look at how to connect all those wonderful
devices to your laptop or desktop. Almost all such
connections (that are not wireless connections) are through a
“USB” port cable. USB stands for Universal Service Bus, and,
just as a city bus can carry all kinds of people, a USB connection can connect almost anything. The purpose of this article is
to provide you with the information you need to connect things
using the USB connection port. All computers have at least two
and maybe three or more USB ports. They are rectangular
“holes” in your computer, approximately one-half inch wide by
3/16 inch thick. Any device you purchase which can connect to
your computer will probably come with a connection cable with
one end being a USB port connector. The other end of the cable
will probably have a different shape, which plugs into the device you are connecting (camera, printer, mouse, etc.). Here is
how you connect something to your computer using this port:
1. Using the connection cable, plug your device into your
computer’s USB port. (The USB plug does have a “right side
up,” so if it doesn’t fit one way, turn it over).
That’s it. There is no second step. Oh — maybe you have to
turn on the device you are connecting.
Yes, it’s simple, but I think it is helpful to know a little of
what is going on and how to best use your USB ports on your
computer. For example, did you know you can have as many
(Continued on page 16)

More on fonts ...
(Continued from page 14)

ments, you can still use fonts creatively. Paying attention to how
professionals use text in magazines and web pages can give you
ideas for creative font use. For example, you can select the first
letter of the first word in a paragraph and make it a different
font in a larger size for a dramatic effect. While it isn’t a good
idea to use too many fonts in one document, combining a couple
gives interest to the text. You can make your fonts work for
you.

Members’
classified ads
Classified ads are free to
members. Each ad is limited
to 105 characters, including
spaces and to one ad per
member per month. Copy has
to be to John Weigle, editor of
TOE
(editor@cipcug.org),
within the week after the
regular meeting. Otherwise,
the ad is held to the following
month.

Free

Manual
(.pdf)
http://
pdf.textfiles.com/manuals/
FAXMACHINES/Sharp%
20UX300%20Plain%
20Paper%20Fax%
20Machine.pdf — David Minkin
I have the following For Sale
(contribution to CIPCUG):
2 each Microsoft Mouse, $2
each
Internet
Scrolling
Mouse
(COMP USA), $2
Video Selector Switch (5 inputs/2 outputs), $5 — David
Minkin

For sale

I have the following Free/For Wanted
Sale (contribution to CIPOther categories
CUG):
One SHARP UX-300 FAX as needed
machine with Handset
The Outer Edge is printed and prepared for mailing by:
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Interesting sites to visit on the Internet
By Nancy Preffitt
Member, ICON Users Group, MO
December 2012 issue, The ICON
www.iconusersgroup.com
ngpreffitt (at) juno.com
No time to read
If you find it difficult to set aside time
to read a good book, this site is for you.
Daily Lit offers a ”novel” solution! It
emails chapters of a selected book to you
every day thus allowing you to read in
smaller increments. Just browse the database for a book you want to read, enter
your email address, and click subscribe.
Choose from best-selling and awardwinning titles, literary fiction and romance to language learning and science
fiction. The site also features forums,
where you can discuss your favorite
books and authors.
http:// www.dailylit.com/

An old game in a new technology
Remember Yahtzee? You can now
play on your PC. It’s a single-person
game in this version. You can even
download it as a portable app and store it
on a thumb drive. It’s a geekly site — as
are most open source sites — but it’s easy
to download and enjoy without a hassle.
http://www.openyahtzee.org
Medication interaction
It seems that the older we get, the
more prescriptions we have. Your doctor
or pharmacist may give you basic instructions (or not), but if you have an odd ache
or rash or something, what should you
do? The Physicians’ Desk Reference is
what doctors use. and you can get it
online to acquire more information about
drug reactions and interactions, etc.
Check it out at
http://www.pdr.net.
There’s a site just for consumers which

may be more understandable at http://
www.drugs.com/pdr/
Amazing old photos
These photographs were taken from
color slides found at the Library of Congress. They’re dated from 1939-1943.
The colors are so bright and clear it’s
hard to imagine they’re so old. I enjoyed
the old vehicles, fashions and social habits, too. http://extras.denverpost.com/
archive/captured.asp
Trying to pick a good movie?
Make sure it’s one you’ll like by visiting Rotten Tomatoes first. It takes a look
at dozens of films now playing at theaters, and collects reviews from major
critics. It also lets readers rank the movies, which might provide the best indication of the movie's quality. http://
www.rottentomatoes.com/movie/intheaters/

More on USB ports ...
(Continued from page 15)

USB ports as you need? If you have three
USB ports and they all are used and you
have a fourth device to connect, what do
you do? You go to a store a buy a USB
multiplier (or “splitter”) that connects to
one USB port and provides four more
ports! Believe it or not, you can connect
over 100 different devices through one
USB port.
So what basically happens when you
connect something to a USB port? Well,
the computer, all on its own (please make
sure the device you are connecting is
turned on), identifies the device and establishes the communication code or language it must use to work with the device. If the computer does not have this
code in its memory it will go to the Internet and get it. So it is usually a good idea
to be connected to the Internet when
plugging in something new to your computer. Pretty neat, huh?
If you are connecting some kind of
memory device, such as an external disk
drive or a flash drive, there will be an
exchange of data to and from the device
while you are using it. You can save files

to the device and you can change or delete files already on the device. The only
danger here is what if you disconnect the
device (i.e. unplug it) while it is receiving
information from the computer? The file
could be incomplete — a file error. So,
the idea is to make sure that the device is
done transferring data before you disconnect it. Here’s how to safely disconnect a
memory device:
In Windows, when you connect a
memory device to your computer you will
see a new icon in your SYSTRAY —
those little icons by your clock on the
right end of your taskbar. The icon will
look like a USB cable connector plug and
a green circle with a white checkmark in
it (in Windows 7). It will be tiny, so look
closely. (If you don’t see it, click on the
little arrow to the left of these icons to
reveal the icons that didn’t fit into this
area). Whenever you connect a new
memory device to your computer, Windows assigns it a drive letter. Most computers have the main “C” drive and a CD/
DVD drive assigned the letter “D.” When
you connect another memory device to
your computer it would then be assigned

the letter “E.” When you are ready to
disconnect your device, click on this icon.
You will then see a list of all the memory
devices connected to your computer
(most of the time it will be only one device). Click on the specific device on the
list to tell the computer you are through
using it. You should then see a message
displayed that says it is safe to remove the
device. It is just a little extra step to make
sure you are not unplugging a device
while it is in use. Another way is to simply turn off the device before you disconnect it.
There are other connection ports (i.e.
“holes”) in your computer where you can
plug things in, like the ISDN connector,
monitor, keyboard, mouse, and other cables. Make sure you are plugging your
USB plug into a USB port — match the
shape carefully! Remember, there IS a
“right side up” on the plug too, so if it
does not go in one way, turn it over and
try again. Never force a plug into a port!
USB ports have made connecting
many devices very easy. So go ahead and
buy that camera or jump drive and plug it
in!
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Keyboard shortcuts — 2

Microsoft offers different ways to do things
By Jim Thornton
jasthorn@gmail.com
ll of the Microsoft Windows
computer programs include
many keyboard shortcuts.
F keys
Here are the keyboard shortcuts for
the F keys on your keyboard:
F1 = Help.
F2 = Renames icons, files, and folders.
F3 = Searches for files when your
desktop is displayed.
F4 = Opens a selected drive in Windows Explorer.
F5 = Refreshes current display.
F6 = Moves your cursor to a different
Windows Explorer panel.
F8 = Reboots your computer into the
Safe Mode.
F10 = File menu bar is displayed.
As you can see, F7 and F9 are missing. There are several other shortcuts
using the F keys with another key:
F1+WINKEY = Help.
F4+ALT = Closes the current program.
F4+CTRL = Closes the Multiple Document Interface window.
F6+ALT = Switches between several
open windows of the same program.
F10+SHIFT = Opens shortcut menu.
Alt keys
The next group of shortcut keys is
using your ALT key with another key:
ALT+CTRL+DEL = Opens Task
Manager.
ALT+DOWN ARROW = Opens a
drop down list box.
ALT+ENTER = Opens properties of a
selected icon or program.
ALT+ESC = Switches between open
applications.
ALT+F4 = Quits an open program.
ALT+F6 = Switches between multiple
windows in the same program.
ALT+PRINT SCREEN = Prints only
the selected screen area.

A

ALT+SHIFT+TAB = Reverse
the
direction of ALT+TAB.
ALT+SPACE = Displays the window’s System menu.
ALT+TAB = Switch between open
programs.
ALT+- = (alt+hyphen) Displays Multiple Document Interface.
ALT+_ = (alt+underline) Opens the
menu.
ALT+ALT = Displays the properties
of a file.
ALT+underlined letter in dialog box
= Moves corresponding item.
Left ALT+left SHIFT+NUM LOCK
= Toggles mouse keys on and off.
Left
ALT+left
SHIFT+PRINT
SCREEN = Toggles high contrast on and
off.
Shift keys
The next group of shortcut keys is
your SHIFT key:
SHIFT = when inserting a CD-ROM
bypasses the automatic run feature.
SHIFT (five times) = Toggles sticky
keys on and off.
SHIFT+CLOSE BUTTON = Closes
the current folder and all related folders.
SHIFT+CTRL+ESC = Opens Windows Task Manager.
SHIFT+DELETE = Deletes a selected
item and doesn’t place the deleted item
into your Recycle Bin.
SHIFT+F10 = Displays a shortcut or
context menu.
SHIFT+NUM LOCK+ALT = Toggles mouse keys on and off.
SHIFT+PRINT SCREEN+ALT =
Toggles high contrast on and off.
SHIFT+right click = Displays a
shortcut menu.
SHIFT+SHIFT = Runs an alternate
default command.
SHIFT+TAB = Moves back to previous dialog box.
SHIFT+WINDOWS LOGO+M =
Unminimize all selected items.

Windows keys
And now the last group of shortcut
keys is using your Windows LOGO key,
which is your Windows key:
LOGO = Start menu.
LOGO+A = starts Accessibility Options.
LOGO+C = Open Control Panel.
LOGO+D = Minimizes all open windows and displays.
LOGO+E = Windows Explorer.
LOGO+F = Files or folders.
LOGO+I = Opens Mouse Properties
dialog box.
LOGO+K = Open Keyboard Properties dialog box.
LOGO+L = Log off Windows.
LOGO+M = Minimizes all.
LOGO+P = Starts printer manager.
LOGO+R = Runs dialog box.
LOGO+S = Toggles CAPS LOCK on
and off.
LOGO+V = Starts Clipboard.
LOGO+BREAK = System properties
dialog box is displayed.
LOGO+CTRL+F = Find computer.
LOGO+CTRL+TAB = Moves focus
from Start to the Quick Launch toolbar.
LOGO+F1 = Help.
LOGO+SHIFT+M = Undoes the minimizing of all.
LOGO+SPACEBAR = Displays a list
of Microsoft IntelliType shortcut keys.
LOGO+TAB = Cycle through taskbar
buttons.
As you can see B, G, H, J, N, O, Q, T,
U, W, X, Y, and X are missing.
General information
In my previous article on keyboard
shortcuts, I identified the Microsoft
webpage
http://support.microsoft.com/
kb/126449, which provides a listing of
numerous Windows key combinations.
And don’t be concerned that not all of
these shortcut keys are working on your
computer. I have less than half of these
keys that are working on my Windows 7
computer.

Page 18

The Outer Edge

March 2013

General news, commentary
Initials
BDV

Name
Bob de Violini

(805)
rjddev@gmail.com

BR

Bill Robinson

389-2997 (b)
bill@bzus.com

DM

David Minkin

469-6970 (cell);
484-2974 (home);
dddave@cipcug.org

MS

Michael Shalkey mshalkey@cipcug.org

If you would like to volunteer to help others, please send
your contact information and programs you’re willing to
help on to editor@cipcug.org.

F1—Your Help Key

........................

(Revised Sept. 7, 2008)

WEB HELP SITES (Updated 3-5-13)
DSL reports: www.dslreports.com
Steve Gibson: www.grc.com
Kim Komando: www.komando.com
Leo Laporte: www.leoville.com; techguylabs.com/
(among others)
Jeff Levy: www.jefflevy.com
Linux distributions: www.DistroWatch.com
Microsoft: www.microsoft.com
OnGuard Online: www.onguardonline.gov
PCMag: www.pcmag.com
PC Pitstop: www.pcpitstop.com
PC World: www.pcworld.com
Recalled products: www.recalls.gov
SANS Institute — Computer Security Education and
Information Security Training: www.sans.org
Spyware Warrior: www.spywarewarrior.com
User Group Relations (Gene Barlow): www.ugr.com
Ventura County Computers (Rick and Toby’s shop):
www.vccomputers.com
Virus Bulletin: www.virusbtn.com/index
Windows Secrets: www.windowssecrets.com
Windows
The
Official
Magazine
(UK):
www.officialwindowsmagazine.com/

COMMUNICATIONS/INTERNET (GENERAL)
World Wide Web
DM
DATABASES
Access

BR

E-MAIL
Outlook
Outlook Express
Thunderbird

MS
BR, DM
MS

GRAPHICS PROGRAMS
IrfanView
Paint Shop Pro
Photo Shop Elements
Print Shop

MS
DM
BR
BR

SPREADSHEETS
Microsoft Excel

DM

WORD PROCESSING
Microsoft Word
WordPerfect

DM
DM

WINDOWS
Windows 98, 95
Windows 2000
Windows XP

DM, MS (98)
BDV
DM

If you have a favorite help site on the Web, please forward
it, so we can expand the section. If you find a link that
doesn’t work, please tell us that, too.
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Why join Channel Islands PC Users
Group (CIPCUG)?
Every month, members of the Channel
Islands PC Users Group have access to:
♦ The Outer Edge newsletter, which
includes a list of members willing to help
other members.
♦ The general meeting, featuring a
question-and-answer session and program
on new software or hardware.
♦ Special Interest Groups — special
meetings held monthly.
♦ Door prizes and raffle at the
regular meeting.
Other benefits include:
♦ Special user group discounts on

books and software.
♦ A flash drive containing many
useful freeware programs.
♦ A chance to make friends with
people who have similar interests.
♦ The ability to put your knowledge
to good use by helping other members.
The whole concept of user groups is
members helping members.

CIPCUG.
Dues for new members
Individual member, $40.
Family membership (same address),
$55.
Renewals are $30 and $35 per year
respectively.
TOE subscription only (in the U.S.),
$20.

CIPCUG E-MAIL ADDRESS
Please clip the coupon below and send
Members who would like to have an
with payment to CIPCUG-Membership,
email address through CIPCUG in the
P.O. Box 51354, Oxnard, CA 93031form of YourName@cipcug.org may ob1354.
tain one for $20 per year.
Please make checks payable to

CIPCUG MEMBERSHIP
APPLICATION

Can you help the club as a volunteer? If so, what would you
be interested in working on? Please list on separate sheet. If
necessary.

Amount enclosed: ____________________________
Please Print the following information:

For CIPCUG use:
Date __________________

Name: _______________________________________
Member # ____________
Address: ______________________________________

City: ___________________________,

State:________ ZIP Code: ________________

Phone (Home): ______________(Work): ______________

E-mail address: ________________________________

User level: Novice ____; Intermediate _____;
Advanced _____

The Outer Edge
Channel Islands PC Users
Group Inc.
Page 20
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DUES REMINDER
If the code above your
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March 2013 meeting
of the Channel Islands PC Users Group
The map shows
the easiest route
to the Boys &
Girls Club, but if
you prefer, you
can take the
Carmen Drive
offramp to
Ponderosa Drive,
which leads to
Temple Avenue.

Saturday morning, March 23, at the Boys
& Girls Club, 1500 Temple Ave.
(Ponderosa Drive and Temple Avenue),
Camarillo.
Meeting schedule:
8:00 a.m.
Doors open
8:30
SIG (Probably just the connectivity
and email SIG)
9:30
Business meeting
10:00
Q&A
10:30
Break
Program (Webinar by Gene Barlow)
11:00
Drawing

